
Studio Holder  
NLE Roundtrip & Delivery Guidelines for Digital Cinema & High-End TV        ​(OS: macOS Catalina Ver 10.15.7) 
Last Updated: Thursday 12th November 2020 
USEFUL LINKS & RESOURCES: 
Studio Holder - Project Workflow for Film & HETV 
Studio Holder - Post Production File Structure V2.2 
Studio Holder - Avid MC Fiction/Doc Bin Container Layout 
Studio Holder - Avid MC Fiction/Doc Track Layout/Allocation Convention 
Studio Holder - UHD/HD Blu-Ray & DVD Authoring Convention 
CONTENTS: 

 

Page 1 

Workflow Process  Software/Hardware Used  Resultant Output  Pages 

Roundtrip Processes 

Camera/Set ​➜​ DIT / MCR  Digital Cinema Camera ​➜ 
HEDGE ​➜ ​Project Hard Drive/Storage 

   

Offline Edit ​➜​ Grade  Avid Media Composer ​➜ ​DaVinci​ ​Resolve     

Offline Edit ​➜​ Sound Edit/Design/Mix  Avid Media Composer ​➜ ​ProTools     

Grade ​➜​ VFX  DaVinci Resolve ​➜ ​NUKE     

Grade ​➜​ Sound Edit/Design/Mix  DaVinci Resolve ​➜ ​ProTools     

Grade ​➜ ​Offline Edit  DaVinci Resolve ​➜ ​Avid Media Composer     

Sound Edit/Design/Mix ​➜ ​Offline Edit   ProTools ​➜ ​Avid Media Composer     

VFX ​➜ ​Online Edit  Nuke ​➜ ​Avid Media Composer     

Delivery Processes 

Exporting a ​MASTER​ Deliverable  Avid Media Composer OR 
DaVinci Resolve 

Apple ProRes 4444 / 422 
HQ 

 

Exporting a ​REFERENCE / REVIEW /​ ​VIEWING 
Deliverable 

Avid Media Composer OR 
DaVinci Resolve 

.MP4 / H.264   

Authoring a DCP from a MASTER 
Deliverable using ​DCP-O-Matic 2 

Master Deliverable ​➜ ​DCP-O-Matic 2 ​➜ ​Linux 
EXT-2 Formatted Hard Drive 

DCP   

Authoring a BLU-RAY DISC from a MASTER 
Deliverable using ​Compressor 

Master Deliverable ​➜ ​Compressor ​➜ ​(Authored) 
Blu-Ray Disc 

(Authored) Blu Ray Disc   

Uploading a MASTER or REF. Deliverable to  Master/Reference Deliverable ​➜ ​Frame.io ​➜  Deliverable on Frame.io   

Software Packages & Version Information 

DIT / MCR ​➜  Offline Edit ​➜  Grade ​➜  VFX ​➜  Sound ​➜  Deliver ​➜  DCP Deliver ​➜  Upload ​➜ 

Hedge  Avid Media 
Composer 

DaVinci Resolve  NUKE  ProTools  DaVinci Resolve  DCP-O-Matic 2  Frame.io 

               

Ver: 20.3.1  Ver: 2020.10  Ver: 17.0.0  Ver: N/A  Ver: 10.5.1  Ver: 17.0.0  Ver: 2.14.38  Ver: 2.5.2 
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ROUNDTRIP PROCESSES 

 
Camera/Set ➜ DIT / MCR 
Digital Cinema Camera ​➜​ HEDGE ​➜ ​Project Hard Drive/Storage 
 
It is recommended you read a guide to keeping cards and rushes safe before proceeding with reading and undertaking 
this step. There are important principles to take heed of which can vary depending on the project’s delivery 
requirements and the materials recorded/gathered at the very start of post-production. It is essential you know how to 
handle different file formats/types and the steps involved.  
 
HEDGE is an industry-standard backup, copying and archival application which simplifies these essential processes and 
mitigating data errors where possible. You can select your source (which may a camera’s memory card, hard drive or 
other connected source) and your destination (or multiple destinations) (which may be your project’s hard drive, media 
server or other connected destination). Each completed transfer automatically generates a Transfer Log Sheet which is a 

 

Page 2 

Frame.io  Client Review or Delivery 

Delivery - Resolutions & Aspect Ratios 

  4K  2K  HD 

DCI “Cinema-Standard” 
Formats 

     

Full Container  4096 x 2160 ​(1.90:1)  2048 x 1080 ​(1.90:1)   

Flat  3996 x 2160 ​(1.85:1)  1998 x 1080 ​(1.85:1)   

Scope  4096 x 1716 ​(2.39:1)  2048 x 858 ​(2.39:1)   

Prosumer Formats       

16:9 Formats  3840 x 2160 ​(16:9) ​(1.77:1)  2048 X 1152 ​(16:9) ​(1.77:1)  1920 x 1080 ​(16:9) ​(1.77:1) 

4:3 Formats  4096 X 3072 ​(4:3)​ (1.33:1)  2048 x 1536 ​(4:3)​ (1.33:1)  1920 x 1440 ​(4:3)​ (1.33:1) 

Other Formats  4096 X 2458 ​(5:3)​ (1.66:1)  2048 x 1229 ​(5:3)​ (1.66:1)  1920 x 1152 ​(5:3)​ (1.66:1) 

Software Packages & Version Information 

DIT / MCR ​➜  Offline Edit ​➜  Grade ​➜  VFX ​➜  Sound ​➜  Deliver ​➜  DCP Deliver ​➜  Upload ​➜ 

Hedge  Avid Media 
Composer 

DaVinci Resolve  NUKE  ProTools  DaVinci Resolve  DCP-O-Matic 2  Frame.io 

               

Ver: 20.3.1  Ver: 2020.10  Ver: 17.0.0  Ver: N/A  Ver: 10.5.1  Ver: 17.0.0  Ver: 2.14.38  Ver: 2.5.2 



Studio Holder  
NLE Roundtrip & Delivery Guidelines for Digital Cinema & High-End TV        ​(OS: macOS Catalina Ver 10.15.7) 
Last Updated: Thursday 12th November 2020 
permanent text-based record verifying the transfer process which may also be useful as proof of work as a DIT or upon 
ingesting/delivering files.  
 
There is also an accompanying mobile app which synchronises the progress made on your desktop and is especially 
useful if you are multi-roleing on-set or are required to be elsewhere or otherwise occupied, so you can be kept updated 
when transfers are complete and also their current progress. 
 
HEDGE is a paid software which can be downloaded ​here​. 

 
Offline Edit ➜ Grade 
Avid Media Composer ​➜ ​DaVinci​ ​Resolve 
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● Duplicate the Sequence, and click 
the NEW sequence 

● Highlight All Tracks (MARK IN at first 
frame, MARK OUT at last frame) 

● Right Click on (PICTURE-LOCKED) 
SEQUENCE 

● Click ‘Export’ 
● In ‘Export As’, choose AAF 

○ TICK: Use Marks, Use 
Enabled Tracks and AAF 
Edit Protocol 

○ TICK: Include All Video / 
Data Tracks in Sequence, 
Include Audio Tracks in 
Sequence 

○ Export Method: Link to 
(Don’t Export) Media. 

● SAVE   

 

● Open DaVinci Resolve 17 
● Create New Project 
● File > Import Timeline > Import AAF, 

EDL, XML… 
● Locate the saved .AAF File 
● In the ‘Load AAF…’ window. Ensure 

the following is checked: 
○ Set Timeline Name 
○ Set Master Start Timeline 
○ Ensure Settings are 

Correct (Project Settings, 

 

Software Packages & Version Information 

DIT / MCR ​➜  Offline Edit ​➜  Grade ​➜  VFX ​➜  Sound ​➜  Deliver ​➜  DCP Deliver ​➜  Upload ​➜ 

Hedge  Avid Media 
Composer 

DaVinci Resolve  NUKE  ProTools  DaVinci Resolve  DCP-O-Matic 2  Frame.io 

               

Ver: 20.3.1  Ver: 2020.10  Ver: 17.0.0  Ver: N/A  Ver: 10.5.1  Ver: 17.0.0  Ver: 2.14.38  Ver: 2.5.2 

https://hedge.video/how-it-works
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Offline Edit ➜ Sound Edit/Design/Mix 
Avid Media Composer ​➜ ​ProTools 
 
Typical Requirements from Sound Designer/Re-Recording Mixer: ​A VIEWING Deliverable​ + AAF (with Embedded Media) + 
‘X’ amount of handles 
 
Step 1: Exporting an AAF 
Step 2: Delivery of AAF & Associated Files to Sound Mixer 
Step 3: Reimporting Mix & Output 
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Ingesting Source Clips into 
Media Pool) 

○ Set Timeline Resolution 
● Click OK. 
● Wait for DaVinci to load .AAF 

(​Resolve is currently scanning 
media storage/hard drive for the 
original media and preparing the 
sequence for grading 
automatically​). 

 

Exporting an AAF 
● With your sequence setup and 

pre-mixed, turn on all tracks in the 
sequence. From the file menu, 
choose EXPORT… 

● In ‘Export Setting’, change the 
Preset to CONSOLIDATE AUDIO TO 
FOLDER 

● Click ‘Options’ 
● In ‘Export As…’ – change to AAF. 
● TICK: Use Enabled Tracks 
● TICK: AAF Edit Protocol 
● TICK: Include All Audio Tracks 
● On the Audio Tracks tab, set Export 

Method to CONSOLIDATE MEDIA 
but change handles to something 
between 120-180 frames to give 
sound mixer handles to work with. 

 

Software Packages & Version Information 

DIT / MCR ​➜  Offline Edit ​➜  Grade ​➜  VFX ​➜  Sound ​➜  Deliver ​➜  DCP Deliver ​➜  Upload ​➜ 

Hedge  Avid Media 
Composer 

DaVinci Resolve  NUKE  ProTools  DaVinci Resolve  DCP-O-Matic 2  Frame.io 

               

Ver: 20.3.1  Ver: 2020.10  Ver: 17.0.0  Ver: N/A  Ver: 10.5.1  Ver: 17.0.0  Ver: 2.14.38  Ver: 2.5.2 
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● TICK: Include Rendered Audio 
Effects and Render All Audio 
Effects 

● UNTICK: Remove Track Effects 
● Change the Convert Audio Format 

to AIFF. 
● In the Media Destination section, 

switch the audio option to be 
EMBEDDED IN AAF. 

● Double-check all settings and then 
choose SAVE. 

Delivery of AAF (and Associated Files) to 
Sound Mixer 

● Check Prior Correspondence from 
Sound Designer / Re-Recording 
Mixer about any specific/unique 
delivery specifications 

● Create a Folder on the Project’s 
Hard Drive called 
‘PROJECT_TITLE_FILES_FOR_PROTOO
LS’ and include: 

○ X1 Viewing Deliverable 
○ AAF (with Embedded 

Media) 
● Create Google Drive Folder 

entitled the same as above: 
‘PROJECT_TITLE_FILES_FOR_PROTOO
LS’ and include: 

○ X1 Viewing Deliverable 
(as above) 

○ AAF (with Embedded 
Media) (as above) 

● Share GDrive Folder with the Email 
Address of the Sound Designer / 
Re-Recording Mixer. 

● They should be able to open the 
Project in ProTools and begin 
mixing.  

Re-Importing Mix & Output 
● Final Mix should be received as a 

.WAV bounced file​. Where possible, 

Software Packages & Version Information 

DIT / MCR ​➜  Offline Edit ​➜  Grade ​➜  VFX ​➜  Sound ​➜  Deliver ​➜  DCP Deliver ​➜  Upload ​➜ 

Hedge  Avid Media 
Composer 

DaVinci Resolve  NUKE  ProTools  DaVinci Resolve  DCP-O-Matic 2  Frame.io 

               

Ver: 20.3.1  Ver: 2020.10  Ver: 17.0.0  Ver: N/A  Ver: 10.5.1  Ver: 17.0.0  Ver: 2.14.38  Ver: 2.5.2 
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Grade ➜ VFX 
DaVinci Resolve ​➜ ​NUKE 
 

 
Grade ➜ Sound Edit/Design/Mix 
DaVinci Resolve ​➜ ​ProTools 

 
 
 
 
 
 
 
 
 
 
 
 
 
Grade ➜ Offline Edit 
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request from the sound mixer the 
individual STEMs and ProTools 
Session File to re-access later on 
(for further editing and/or archival) 
later on. These will be subsequent 
WAVs / Project Files. Enquire within.  

● Import the sound and ensure the 
AVID track matches the output of 
the mix. (i.e if the mix is 5.1, set the 
new sequence to 5.1 – do NOT use 
the existing avid sequence). 

● Output Project – see above for 
MASTER​ and ​VIEWING​ methods. 

 

●    

Software Packages & Version Information 

DIT / MCR ​➜  Offline Edit ​➜  Grade ​➜  VFX ​➜  Sound ​➜  Deliver ​➜  DCP Deliver ​➜  Upload ​➜ 

Hedge  Avid Media 
Composer 

DaVinci Resolve  NUKE  ProTools  DaVinci Resolve  DCP-O-Matic 2  Frame.io 

               

Ver: 20.3.1  Ver: 2020.10  Ver: 17.0.0  Ver: N/A  Ver: 10.5.1  Ver: 17.0.0  Ver: 2.14.38  Ver: 2.5.2 
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● Ensure ALL Colour Grading is complete. 
● Click the ‘DELIVER’ tab (the launching 

rocket) 
● Choose the Avid AAF Preset.  
● Click Browse and select a well-named 

location for Rendered Files. (i.e – AAF 
Export from DaVinci). 

● Make sure Individual Clips is selected. 
This will render out individual MXF Files 
for each shot in your sequence. 

● Select ‘MXF OP-Atom as the File 
Format’.  

● For Codec, select ‘DNxHR’… (ensure 
resolution, colour space etc all 
matches to original source media). 

● Tick ‘Render at Source Resolution’ or 
select the Final Delivery Resolution the 
project intends to be. 

● Click ‘Add to Render Queue’ and 
Launch. 

● Await for Render to be complete, it’ll 
be in destination folder – this will 
contain the new MXF media files for 
Avid and an included AAF file as well. 

 

 

● Now, for Avid Media Composer – these 
are the steps that are necessary to 
conform the GRADED project back 
into the film’s project. 

● Copy MXFs 
● Copy new MXF files that DaVinci 

Resolve created into a new numbered 
folder inside your ‘Avid MediaFiles’ 
folder. Go to your hard drive >> Avid 
MediaFiles >> MXF and create a new 
numbered folder. 

● Open Avid Media Composer (once 
STEP A is complete) 

● Create a new bin titled “DaVinci to 
AVID”.  

 

Software Packages & Version Information 

DIT / MCR ​➜  Offline Edit ​➜  Grade ​➜  VFX ​➜  Sound ​➜  Deliver ​➜  DCP Deliver ​➜  Upload ​➜ 

Hedge  Avid Media 
Composer 

DaVinci Resolve  NUKE  ProTools  DaVinci Resolve  DCP-O-Matic 2  Frame.io 

               

Ver: 20.3.1  Ver: 2020.10  Ver: 17.0.0  Ver: N/A  Ver: 10.5.1  Ver: 17.0.0  Ver: 2.14.38  Ver: 2.5.2 
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Sound Edit/Design/Mix ➜ Offline Edit  
ProTools ​➜ ​Avid Media Composer 
 

 
VFX ➜ Online Edit 
Nuke ​➜ ​Avid Media Composer 
 

 
 
 
 
 
 
 
 
 
 
 
 
Exporting a MASTER Deliverable 
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● Right-click on bin, select Input > Import 
Media 

● Navigate to new numbered folder in 
Avid MediaFiles folder and select 
precisely the ​msmMMOB.mdb​ file. 

● Import AAF 
● Input > Import Media 
● Navigate to same folder where 

Resolve saved the Renders and select 
the included AAF file. Click OK. You 
should see a new sequence icon show 
up in the bin.  

● This is your sequence from DaVinci 
Resolve with the new colour correction 
changes. 

Software Packages & Version Information 

DIT / MCR ​➜  Offline Edit ​➜  Grade ​➜  VFX ​➜  Sound ​➜  Deliver ​➜  DCP Deliver ​➜  Upload ​➜ 

Hedge  Avid Media 
Composer 

DaVinci Resolve  NUKE  ProTools  DaVinci Resolve  DCP-O-Matic 2  Frame.io 

               

Ver: 20.3.1  Ver: 2020.10  Ver: 17.0.0  Ver: N/A  Ver: 10.5.1  Ver: 17.0.0  Ver: 2.14.38  Ver: 2.5.2 
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● In the desired sequence, select ALL 
Tracks (Cmd+A) 

● Right-click on the ‘Record’ window of 
the film/programme itself 

● A dialogue box will appear prompting 
selection of a save location - Select 
‘Options’ 

● In Export Options (now known as UME File 
Export) ensure the following are 
selected: 

a. Export As: ​MOV 
b. Use Selected Tracks 
c. VIDEO 
d. Source Raster - ​Project Raster 
e. Image Preset - ​keep same as 

sequence​ (unless otherwise 
required). This preset refers to 
Resolution & Aspect Ratio. 

f. Aspect Ratio; ​keep same as 
sequence​ (unless otherwise 
required). 

g. Pixel Aspect Ratio; ​keep 
unchanged​. 

h. Source Scaling; ​keep 
unchanged​. 

i. Frame Rate; ​keep same as 
sequence​ (unless otherwise 
required). 

j. Codec Family: ​Apple ProRes 
k. Compression: ​Apple ProRes 422 

HQ 
l. AUDIO 
m. Format: ​PCM 
n. Mix: ​Stereo​ (unless otherwise 

required) 
o. Sampling Rate: ​48000 Hz 
p. Bits per Sample: ​24 

● Click Save. The export will begin. 

MASTER Deliverable Settings 

 
VIEWING/REFERENCE Deliverable Settings 

 

Software Packages & Version Information 

DIT / MCR ​➜  Offline Edit ​➜  Grade ​➜  VFX ​➜  Sound ​➜  Deliver ​➜  DCP Deliver ​➜  Upload ​➜ 

Hedge  Avid Media 
Composer 

DaVinci Resolve  NUKE  ProTools  DaVinci Resolve  DCP-O-Matic 2  Frame.io 

               

Ver: 20.3.1  Ver: 2020.10  Ver: 17.0.0  Ver: N/A  Ver: 10.5.1  Ver: 17.0.0  Ver: 2.14.38  Ver: 2.5.2 
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● In the desired sequence, go to the ​DELIVER Tab 
indicated by a rocket-ship icon at the bottom. 

● In Render Settings - ​select ProRes Master​ and 
check/change the following as appropriate to 
the project’s delivery requirements: 

a. Filename: ​Change to Project 
b. Location: ​Browse and Select a Save 

Location 
c. Render: ​Single Clip 
d. Export Video: ​TICKED 
e. Format: ​QuickTime 
f. Codec: ​Apple ProRes 
g. Type: ​Apple ProRes 422 HQ​ or ​4444 
h. Leave Field Rendering and Network 

Optimization ​UNTICKED 
i. Resolution: ​Set to Desired Resolution 
j. Frame Rate: ​Set to Desired Frame 

Rate​ (keep to same frame rate as 
original media to avoid jumping 
effects!) 

k. Leave Other Settings Unchanged 

 
 
 

     

Software Packages & Version Information 

DIT / MCR ​➜  Offline Edit ​➜  Grade ​➜  VFX ​➜  Sound ​➜  Deliver ​➜  DCP Deliver ​➜  Upload ​➜ 

Hedge  Avid Media 
Composer 

DaVinci Resolve  NUKE  ProTools  DaVinci Resolve  DCP-O-Matic 2  Frame.io 

               

Ver: 20.3.1  Ver: 2020.10  Ver: 17.0.0  Ver: N/A  Ver: 10.5.1  Ver: 17.0.0  Ver: 2.14.38  Ver: 2.5.2 
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Authoring a DCP from a MASTER Deliverable using ​DCP-O-Matic 2 
 

Things You need to know: 
● Cinema Projectors can only ingest and play a certain type of file: a DCP (Digital Cinema Package) 
● Cinema Projectors can only recognise certain hard-drive formats: Extended Filesystem (i.e EXT-2) 
● DCPs cannot be played or tested using conventional ‘media players’ like QuickTime or VLC and 

require specialist applications and hardware. For best results, DCPs should always be tested in an 
actual cinema. 

● Most film festivals require filmmakers to have a DCP deliverable.  
 
How to make a DCP: 

● Step 1: Have Your File Ready 
○ Very simply, you will need to use your master file to make the DCP, which will always 

output at 2K minimum. Don’t worry if your file isn’t in 2K Resolution, if your file is in HD, you 
should create a 2K DCP. Any text/subtitles should be burned in and you should have the 
relevant sound levels required. Make sure there is no more than 3 secs black at start/end. 

○ Ideally your master file should be a QuickTime Apple ProRes File, as it is more than likely you 
will also be required to submit this type of file as well for festival consideration. 

● Step 2: Open DCP-O-Matic 
○ DCP-O-Matic is a free open-source application that you can download from the internet 

here. 
○ Create a new file, name it, and make sure you know where it’s saving. 
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Software Packages & Version Information 

DIT / MCR ​➜  Offline Edit ​➜  Grade ​➜  VFX ​➜  Sound ​➜  Deliver ​➜  DCP Deliver ​➜  Upload ​➜ 

Hedge  Avid Media 
Composer 

DaVinci Resolve  NUKE  ProTools  DaVinci Resolve  DCP-O-Matic 2  Frame.io 

               

Ver: 20.3.1  Ver: 2020.10  Ver: 17.0.0  Ver: N/A  Ver: 10.5.1  Ver: 17.0.0  Ver: 2.14.38  Ver: 2.5.2 
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● Step 3: Add Your File 
○ Click Add File and choose your Master File. 
○ The programme will then check the file automatically and you will be able to see a 

preview in the window. 
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Software Packages & Version Information 

DIT / MCR ​➜  Offline Edit ​➜  Grade ​➜  VFX ​➜  Sound ​➜  Deliver ​➜  DCP Deliver ​➜  Upload ​➜ 

Hedge  Avid Media 
Composer 

DaVinci Resolve  NUKE  ProTools  DaVinci Resolve  DCP-O-Matic 2  Frame.io 

               

Ver: 20.3.1  Ver: 2020.10  Ver: 17.0.0  Ver: N/A  Ver: 10.5.1  Ver: 17.0.0  Ver: 2.14.38  Ver: 2.5.2 
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● Step 4: Set Your Content 

○ These are really important - as you can’t check the file, you need to be very sure before 
you create the DCP, that all of the settings are set correctly. 

○ When setting the content, ensure the preview pane has someone’s face in it so you can 
look out for stretching errors. 

○ Settings: 
■ Type: 2D (Leave Unchanged) 
■ Scale To: Set your Aspect Ratio (Only change if necessary) 
■ Colour Conversion: Rec. 709 (Leave Unchanged) 

○ Beware: Files that are 16:9 should be using 16:9 on both tabs as their setting, and the same 
goes for 1.85.1 etc. I’d only suggest using Full Frame if your film is cropped/masked so the 
container is actually different to the picture you see. If this is the case you can try different 
settings (changes viewable in the preview window) until it looks correct. 
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Software Packages & Version Information 

DIT / MCR ​➜  Offline Edit ​➜  Grade ​➜  VFX ​➜  Sound ​➜  Deliver ​➜  DCP Deliver ​➜  Upload ​➜ 

Hedge  Avid Media 
Composer 

DaVinci Resolve  NUKE  ProTools  DaVinci Resolve  DCP-O-Matic 2  Frame.io 

               

Ver: 20.3.1  Ver: 2020.10  Ver: 17.0.0  Ver: N/A  Ver: 10.5.1  Ver: 17.0.0  Ver: 2.14.38  Ver: 2.5.2 
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(Switch to DCP Tab above these settings) 
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● Rename DCP to film name etc 
● Next to ‘Use ISDCF name’ click Details and 

change details where appropriate. 
● Content Type: Change as Appropriate (i.e 

Short) 
● Leave Everything Else Unchanged 
● The ‘SMPTE’ (ISDCF) name box should 

always be TICKED too.  
● Unless specifically requested by a festival, 

NEVER tick the ‘Encrypt’ box - this can 
prevent cinemas from ingesting the DCP. 

● The ‘signed’ box will not visually affect your 
DCP, however I would always UNTICK this 
as it prevents the DCP from being 
manipulated by whoever is receiving it. 

● Video Container/Resolution/Frame Rate 
should match (or be changed to match) 
the source file.    

Software Packages & Version Information 

DIT / MCR ​➜  Offline Edit ​➜  Grade ​➜  VFX ​➜  Sound ​➜  Deliver ​➜  DCP Deliver ​➜  Upload ​➜ 

Hedge  Avid Media 
Composer 

DaVinci Resolve  NUKE  ProTools  DaVinci Resolve  DCP-O-Matic 2  Frame.io 

               

Ver: 20.3.1  Ver: 2020.10  Ver: 17.0.0  Ver: N/A  Ver: 10.5.1  Ver: 17.0.0  Ver: 2.14.38  Ver: 2.5.2 



Studio Holder  
NLE Roundtrip & Delivery Guidelines for Digital Cinema & High-End TV        ​(OS: macOS Catalina Ver 10.15.7) 
Last Updated: Thursday 12th November 2020 

● Step 5: Jobs > Make DCP 
○ Click ‘Jobs’ in the taskbar at the top > Make DCP 
○ A ‘Hints’ dialog box may appear showing you some potential issues that may arise in the 

DCP you are about to launch. Check again your aspect ratio settings; frame rate settings 
and audio levels and, if satisfied, click ‘Make DCP’. 

○ When finished it will say “OK - Ran for (time taken)” 
 

Authoring a BLU-RAY DISC from a MASTER Deliverable using ​Compressor 
 
For Full Information on how to author a Blu-Ray Disc (or DVD) from a MASTER Deliverable using ​Compressor​. 
Click Here​. 

 
Uploading a ​MASTER​ or ​REFERENCE/VIEWING​ Deliverable to ​Frame.io 
 
Frame.io​ is increasingly becoming an industry standard all-in-one cloud-based media management, 
project reviewal and active/archival storage space which works via a web-based app from a browser. It 
can also be installed on your computer and even integrated as a native ‘plug-in’ which lives within your 
commonly used editing applications such as ​Final Cut Pro X, Premiere Pro, After Effects, DaVinci Resolve 
and ​Avid Media Composer. ​It is a paid software which you can download by ​clicking here​. 
 
Find out more about uploading to your Frame.io account ​here​. 
Find out more about Creative App Integrations ​here​ (so you can directly deliver to ​Frame.io​ inside the 
editing application itself). 
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https://docs.google.com/document/d/1v2MMnUtuFj_Mkx4Lh_gXPvGo-P5AcnAdXowYQRU94k0/edit?usp=sharing
https://frame.io/
https://support.frame.io/en/articles/7595-create-a-project-and-upload-files
https://frame.io/integrations/

